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12 Configuring the NCD Terminal Emulator

This chapter describes the local NCD Terminal Emulator (ncdterm and
ncdrunterm), which provides VT320 terminal emulation.

The following topics are covered in this chapter:

❏ “Other Sources of Information on the Terminal Emulator” on page 12-1
❏ “Configuring Local Services in the Terminal Host Chooser” on page 12-2
❏ “Configuring a Terminal for Serial Terminal Emulation” on page 12-3
❏ “Configuring Key Translations” on page 12-4
❏ “Configuring the Terminal Emulator Window and Menus” on page 12-5
❏ “Configuring the Window Disconnect Delay” on page 12-12
❏ “Configuring the Answer-Back Message” on page 12-12
❏ “Using VT320 Terminal Emulator Escape Sequences” on page 12-13
❏ “Using Keyboard Escape Sequences” on page 12-34
❏ “Using Compose Key Sequences” on page 12-44
❏ “VT320 Character Coding Conventions” on page 12-51

Other Sources of Information on the Terminal Emulator
This chapter describes resources, escape sequences, and character coding for
the NCD Terminal Emulator. Other documents and other chapters in this
manual contain information about other aspects of the Terminal Emulator:

❏ Using the terminal emulator—The NCDware User’s Guide describes the
appearance and use of the NCD Terminal Emulator choosers and window.

❏ Basic configuration and Keymap Editor—The NCDware System
Administrator’s Guide for UNIX Systems provides information about basic
configuration of the NCD Terminal Emulator (including its use for login),
using the Keymap Editor, and starting the Terminal Emulator without
logging in (ncdrunterm).
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❏ Options and resources—The ncdterm(1) man page provides details on
command-line options and resources.

❏ Configuring printing from the Terminal Emulator—Items in the NCD
Terminal Emulator’s File menu allow the user to send the current screen
or the current session log to a printer attached to the X terminal’s serial or
parallel port. For successful printing, you must configure the port and the
NCD Terminal Emulator. See the System Administrator’s Guide for
configuration instructions.

❏ Downloadable character sets—The NCD Terminal Emulator supports the
use of downloadable character sets (DRCS). See Chapter 17, Keyboards
and Downloadable Keyboard Definitions, for more information.

❏ Technical details—For more detailed technical information about VT320
terminal emulation, see Digital Equipment Corporation publications.

Configuring Local Services in the Terminal Host Chooser
The Terminal Host Chooser provides easy access to the Local File Manager
daemon (filed), Diagnostic daemon(diagd), and Configuration daemon
(configd).

The showLocal resource must be set to “true” (the default) for these services to
be listed automatically in the Terminal Host Chooser. The user can select
Show Local from the Chooser’s View menu to control the display locally.

To access the Local File Manager and Configuration daemon through the
Terminal Host Chooser, you must first set their passwords in the Console
(Setup ⇒ Change Setup Parameters ⇒ Access Control). If you do not set a
password and select one of these local services in the Terminal Host Chooser,
the terminal emulator window appears briefly, displays an “access denied”
message, then disappears.

The resources listed in Table 12-1 control the automatic display of services in
the Terminal Host Chooser. Users can select the corresponding View menu
item to control the display of services locally.
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Configuring a Terminal for Serial Terminal Emulation
To use a serial port for a serial VT320 connection, you can open a serial
terminal emulation session through the NCD Terminal Emulator local client.
The client’s term -ctype serial command allows you to log onto a host and run
non-X applications. For X over a serial line, use XRemote.

On terminals with more than one serial port, you can configure more than one
port for serial terminal emulation. When more than one port is used for serial
terminal emulation, the serial terminal emulator displays a Chooser for
selecting the desired serial connection.

Table 12-1  View Options in the Terminal Host Chooser

View Menu Name Description
Default
Setting

Resource Name

Show Local Controls the automatic display of
services available on the terminal

true showLocal

Show Available LAT Controls the automatic display of
LAT services whose availability
has been broadcast across the
network

true showAvailableLat

Show Default LAT Controls the automatic display of
LAT services listed in the term-
default-hosts table

true showDefaultLat

Show CTerm Controls the automatic display of
available CTERM hosts

true showCTerm

Show Serial Controls the automatic display of
available serial sessions

true showSerial

Show Telnet Controls the automatic display of
TELNET services listed in the
term-default-hosts table

true showTelnet
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Configuring an NCD terminal as an ASCII terminal involves making the
physical connection and setting the parameters. Follow these steps:

1. Attach the terminal to a host via a modem or direct serial connection.
2. Make sure the mode parameter for the port that you wish to use is set to

“terminal” in the serial-interfaces-table.
3. Set the other parameters in the serial-interfaces-table to match the host

computer or modem on the other end of the serial line. Use the suggested
values shown here or set these attributes to match the computer or modem
on the other end of the line:

Configuring Key Translations
The Keymap Editor local client displays a layout of a keyboard that has keys
labelled with their keycaps and the functions (called actions or translations)
assigned to them. The Keymap Editor allows you to change the actions or
translations. For detailed information about using the Keymap Editor, see the
System Administrator’s Guide.

If you are changing key translations using X resources instead of the Keymap
Editor, note that you can specify key translations using more than one
modifier (for example, Shift-Lock-F1).

The keymap action keymap (name) changes keypress translations while the
terminal emulator is running. This action takes a single string argument that
names a resource for dynamically defining a new translation table. The
resource name is derived by appending the string ‘Keymap’ to name. The
keymap argument None restores the original translation table.

The following example shows how the keymap action can be used to add
special keys for entering commonly typed expressions.

baud-rate 38400 (make this as high as possible)

data-bits 8

stop-bits 1

parity None

handshake DTR/DSR, RTS/CTS, or XON/XOFF
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NCDterm.Translations:  #override <Key>F12: keymap (dbx)
NCDterm.dbxKeymap.translations:\\
     <Key>F14: keymap(None) \\n\\
     <Key>F17: string(“next”) string(0x0d) \\n\\
     <Key>F18: string(“step”) string(0x0d) \\n\\
     <Key>F19: string(“continue”) string(0x0d)

Configuring the Terminal Emulator Window and Menus
The NCD Terminal Emulator window provides the same features as an ASCII
terminal. The window displays 24 or 25 lines of text in 80 or 132 columns, and
you can resize it to display fewer or more rows (changing the height) or
columns (changing the width).

The size of the window is affected by several factors, including the font used,
escape sequences sent to the terminal emulator (described later), menu
selections from the menu bar, and X resource specifications.

In addition, you can use character attributes to make text stand out or to
protect fields. You can also choose the cursor.

NCD Terminal Emulator windows provide additional features not found on
traditional terminals, including a scroll bar and menu bar.

Terminal Emulator Fonts
The font you choose for a terminal emulator window is important. It controls
the size of the characters you see as well as whether certain terminal
emulation features appear to work. If you do not know which font to choose,
use the default selected by the terminal emulator.

Fonts are specified using a set of X resources: foundry, family, pointSize, and
subFont. Together with the Fonts menu in the menu bar, these resources
control the actual X font used in the display. See “The Fonts Menu” on page
12-10 for more information about fonts.
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Terminal Emulator Scroll Bars
Scroll bars allow review of information that has passed off the screen. The
ability to see past information is affected by some escape sequences (such as
those that clear certain regions of the screen) and by how much information
the terminal emulator can store.

Scrolling affects terminal memory usage. For more information about
scrolling and memory usage, see the description of the saveLines resource in
the ncdterm(1) man page.

To turn off the scroll bars or change their location, use the scrollbar resource,
also described in the ncdterm(1) man page.

Terminal Emulator Menus
The menu bar provides access to menus for controlling other terminal
emulation features. The menu bar can be disabled using the menuBar resource.

Five menus are accessible from the menu bar: File, Options, Fonts, Cursors,
and Keys.

The File Menu
Table 12-2 summarizes the commands in the File menu.

Table 12-2  File Menu

Menu Item Action

Redraw Redraws the contents of the display window.

Soft Reset Resets the terminal to the default state.

Hard Reset Does a soft reset, deletes all content, and clears any selection.

Close Connection Closes the current session and returns to the Terminal Host Chooser.
This item can be disabled using the disableExits resource. For more
information, see the ncdterm(1) man page.

Start Debugging Log Writes the contents of the session to a log file. This function requires
special setup to execute correctly. For more information, see the
ncdterm(1) man page.
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Print on Serial Line 1 Specifies the serial port to be used for printing.

Serial line 1 is the Auxiliary serial port. If an ESP board is installed,
serial line 2 is the serial port on the ESP board. If a Y connector is in use
on an ESP board, the A connector is serial port 2 and the B connector is
serial port 3.

For terminals with more than one serial port, you can specify the
default port by setting the defaultHost resource to the port number.
The port can be specified in either of the following forms: n, serial n, or
serial/n. For example, you can specify serial port 3 as 3, serial 3, or
serial/3.

Print on Serial Line 2

Print on Serial Line 3

Print on Remote Unit
NCD_name:port

Sends print output to a printer attached to another NCD terminal. The
terminal and port are specified using the printerHost resource. Remote
printing is supported over TCP/IP.

Print on Parallel Line 1 Sends print output to parallel port 1.

Print on Parallel Line 2 Sends print output to parallel port 2 (on terminals with more than one
parallel port).

Print Screen Prints the contents of the display window.

Print Log Buffer Prints the contents of the log buffer (the input and output you can see
by scrolling). Printing starts at the top visible line and extends through
the end of the buffer.

Print Selection Prints selected text in the display window.

Send Break Sends a break character.

Exit Exits from the session. This item can be disabled using the disableExits
resource. For more information, see the ncdterm(1) man page.

Table 12-2  File Menu (Continued)

Menu Item Action
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The Options Menu
The Options menu offers a variety of terminal mode settings. The selections
are all toggles. Options that are set are indicated by filled-in toggle buttons.
The initial states of the Options menu selections are controlled by resources.

Table 12-3 summarizes the Options menu modes and names the associated
resources.

Table 12-3 Options Menu and Associated Resources

Menu Item Resource Name Action

Menu Bar menuBar Enables the menu bar.

Jump Scroll jumpScroll Enables the terminal emulator to add lines to
the screen quickly.

Reverse Video reverseVideo Reverses the foreground and background. For
example, if your terminal is displaying dark
characters on a light background, reverse video
displays light characters on a dark background.

Visual Bell visualBell Specifies flashing instead of an audible bell.

Auto Wraparound autoWrap Specifies that the character typed after the
cursor reaches the right border of the page
automatically appears on the next line. By
default, autowrap is enabled. If autowrap is
turned off, a character typed after the cursor
reaches the right border replaces the character
at the end of the line.

Reverse
Wraparound

reverseWrap Allows the cursor to wrap from the leftmost
column on the line to the rightmost column of
the previous line, allowing you to backspace to
the previous line.

Auto Linefeed autoLineFeed Generates a linefeed automatically. This is for
use with programs that generate carriage
returns without dropping down a line on the
screen.
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Application Cursor
Mode

appCursorMode Generates ANSI escape sequences rather than
standard cursor movements when you use
arrow keys.

Application
Keypad Mode

appKeypadMode Generates control functions rather than
numeric characters when the keypad is used.

Local Flow Control localFlowControl Determines whether flow control characters
(such as Ctrl-S) are passed to the host. By
default, local flow control is enabled. If local
flow control is disabled, flow control characters
are passed to the host.

Allow 80/132
Switching

c132 Allows the terminal emulator to display in the
132-column format required by some
applications.

80/132 Font
Switching

useCondensedFont Switches from the default font to a condensed
font upon receipt of the control sequence that
changes the terminal emulator from 80- to 132-
column mode.

Clear Screen With
Blanks

clearScreenWithBlanks Specifies whether the terminal emulator clears
the screen by erasing the entire screen or by
inserting a screen full of blanks. Enabling this
option allows scrolling to previously displayed
information on terminals connected to certain
hosts. The drawback to using this option is that
it may use up the save-line buffer quickly. The
default is “false,” which clears the screen by
erasing.

Curses Emulation curses Emulates a bug in the UNIX curses screen-
handling package.

Margin Bell marginBell Rings a bell when the cursor reaches the
margin.

Table 12-3 Options Menu and Associated Resources (Continued)

Menu Item Resource Name Action
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The Fonts Menu
The Fonts menu allows you to change the size of the display font dynamically.
The fonts generated through the Fonts menu are defined using a single set of
resource specifications. The specification set defines the “Default” menu
selection, and the terminal emulator uses the Default to generate the other
sizes offered through the menu. The default font is:

-*-terminal-medium-*-normal--*-140-*-*-*-*-*-1

Table 12-4 lists the choices available through the menu and the resources for
defining the Default item.

Strip Parity stripParity Strips parity from any data sent from the host
so that the terminal emulator looks only at
seven-bit bytes.

Grab Keyboard
Input

secureKeyboard Directs keyboard input to the terminal
emulator window. Prevents another user from
seeing key events being sent to the window.

ISO Latin 1 Font latin1Font Enables use of the ISO Latin Alphabet
supplemental character set, which includes
letters with accents and diacritical marks
required in many European languages.

Blink Cursor blinkCursor Specifies whether the cursor should blink.

Visible Status Line statusLine Displays a 25th line at the bottom of the
window, used by applications to display status
information.

Log Output to File Not applicable Logs output to the file opened from the File
menu. If no file is available for output logging,
the item is not active in the Options menu.

Table 12-3 Options Menu and Associated Resources (Continued)

Menu Item Resource Name Action
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The Cursors Menu
The Cursors menu allows you to change the terminal emulator’s cursor by
selecting one of the descriptions in the menu.

You can also press Shift-MB3 (mouse button 3) to shift through the nine
different types of cursors available.

The Keys Menu
The Keys menu (Keys ⇒ Keymap Editor) provides access to the Keymap
Editor (see “Configuring Key Translations” on page 12-4).

Table 12-4  Fonts Menu and Associated Resources

Menu Item Resource Names
Font
Selected

Default foundry, family pointSize, subFont: 14 point

foundry The developer of the font; for example,
adobe. Default: * (the wildcard
character, which ensures that any
foundry matches the font request)

family The family name; for example, courier.
Default: terminal

pointSize The point size of the Default menu
selection (in tenths of a point). Default:
140

subFont The substitute font used if the requested
font cannot be found; should be one of
the built-in fonts. Default: 8x13

Small Not applicable 10.5 point

Large Not applicable 14 point

Jumbo Not applicable 18 point
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Selecting in the Window
You can select arbitrary rectangular sections of an NCD Terminal Emulator
window to cut and paste:

❏ Shift-MB1 (mouse button 1) starts the rectangular selection. The cursor
changes to a plus sign (+).

❏ MB3 extends the selection. The cursor again changes to a plus sign in the
corner of the selection nearest the cursor, allowing you to extend the
selection.

❏ MB2 pastes the selection.
The rectangularCutLineTerminator resource allows you to specify the
terminator added to the end of each line of the rectangular selection. The
default terminator is \n, which inserts a carriage return followed by a
linefeed.

Configuring the Window Disconnect Delay
The disconnectDelay resource allows you to specify the number of seconds to
wait before removing a window after disconnecting from the host. The default
value is one second.

This resource is useful because you can set the disconnect delay to permit
viewing of error messages displayed when the terminal emulator fails to
connect to a host. For example, if a user attempts to connect to the
Configuration daemon without a password, the window can be set to remain
on the terminal long enough for the user to read the message that says a
password is required.

Configuring the Answer-Back Message
The terminal emulator includes the control character ENQ, which decodes to
5. When the terminal emulator receives this code from the host, it sends back
the string in the answerbackString resource.

Typing Ctrl-E causes the terminal to send its answer-back message.
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Using VT320 Terminal Emulator Escape Sequences
An escape sequences is a series of non-printing characters, beginning with an
Escape character, that sends commands to devices. Escape sequences are used
for printing, communications, and display management. The command in an
escape sequence results in specified actions by devices. Escape sequences are
also called control codes or control sequences.

Escape sequences are most often used in scripts, as in the following examples:

cursoroff:    echo "ESC[?25lcursor is off"

cursoron:     echo "ESC[?25hcursor is on"

The NCD Terminal Emulator includes a subset of the VT320 command set, as
well as NCD-specific sequences. These escape sequences, their actions, and
associated functions are listed in Table 12-5. Some of the sequences are
described in more detail following the table.

The table lists sequences that differ depending on whether the environment
requires eight-bit or seven-bit mode. The eight-bit mode sequence (for
example, CSI. . .) is listed first, followed by the equivalent seven-bit mode
sequence (for example, Esc[. . .).

Numerical variables are represented as pn. Variables representing a number of
rows or columns are represented as pr or pc, respectively. Variables requiring a
parameter setting from a number of specific choices are represented by ps.
Other variable types are defined in the table as required.
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Table 12-5  Escape Sequences

Escape Sequence Action
Control
Function

CSI  pn @
Esc [  pn @

Insert pn blank characters.
Default: 1.

ICH

CSI ps $ }
Esc [ ps $ }

See “Configuring the Status
Line” on page 12-27  for
more information.

Select the status line.
ps  specifies the display to which the terminal
sends data.
Permissible values:

0
1

Send characters to main display
Send characters to status line

CSI ps $ -
Esc [ ps $ -

See “Configuring the Status
Line” on page 12-27 for
more information.

Enable the status line. The variable parameter ps
indicates the status line to use.
Permissible values:

0
1
2

No status line
Indicator status line (no-op)
Host-writable status line

CSI ! p
Esc [ ! p

Soft reset

CSI > c
Esc [ > c
or
CSI > 0 c
Esc [ > 0 c

Request secondary device attributes. Response is
C S I > id , ver , 0 c, in which id is terminal
identification and ver is version.
Default response: CSI>1;1;0c

DA

CSI ? ps J
Esc [ ? ps J

Selective erase in display.
Permissible values for ps:

DECSED

0
1
2

Cursor to end of screen
Start to cursor
Entire screen
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CSI ? ps K
Esc [ ps K

Selective erase in line.
Permissible values for ps are:

DECSEL

0
1
2

Cursor to end of line
Beginning to cursor
Entire line

CSI ?  ps ;  ps ... h
Esc [ ?  ps ;  ps ... h

Set Digital private mode.
Permissible values for ps:

1
3
4
5
6
7
8
9

25
40
41
42

44
45
46
47

Cursor keys mode (keypad application)
Column mode (132 column)
Scrolling mode (smooth scroll)
Screen mode (reverse video)
Origin mode
Autowrap mode
Auto-repeat mode
Send MIT mouse row and column on button
press
Text cursor enable mode (cursor visible)
Allow 80-to-132 mode
curses (1) fix
National replacement character set mode
(enabled)
Turn on margin bell
Reverse wraparound mode
Start logging
Use alternate screen buffer

DECCKM
DECCOLM
DECSCLM
DECSCNM
DECOM
DECAWM
DECARM

DECTCEM

DECNRCM

CSI ? ps i
Esc [ ?  ps i

Digital private print control mode. Permissible
values for ps are:

1
4
5
10
11

Print line with cursor
Exit autoprint mode
Enter autoprint mode
Print main display
Print main display

Table 12-5  Escape Sequences (Continued)

Escape Sequence Action
Control
Function
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CSI ? ps ;  ps ... l
Esc [ ?  ps ;  ps ... l

Reset Digital private mode.
Permissible values for ps include:

1
3
4
5
6
7
8
9

10
40
41
42

44
45
46
47

Cursor keys mode (normal cursor keys)
Column mode (80 columns)
Scrolling mode (jump/fast scroll)
Screen mode (normal video)
Origin mode (normal cursor)
Autowrap mode (wraparound)
Auto-repeat mode (disabled)
Do not send MIT mouse row, column on
button press
Text cursor enable mode (cursor invisible)
Do not allow 80-to-132 mode
No curses (1) fix
National replacement character set mode
(disabled)
Turn off margin bell
No reverse wraparound mode
Stop logging
Use normal screen buffer

DECCKM
DECCOLM
DECSCLM
DECSCNM
DECOM
DECAWM
DECARM

DECTCEM

DECNRCM

CSI ?  ps n
Esc [ ? ps n

See CSI ps n.

Table 12-5  Escape Sequences (Continued)

Escape Sequence Action
Control
Function
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CSI ? ps ;  ps ... r
Esc [ ?  ps ;  ps ... r

Store Digital private mode.
Permissible values for ps:

1

3
4
5
6
7
8

9

25
40
41
42

44
45

46
47

Cursor keys mode (normal/application
keypad)
Column mode (80/132 columns)
Scrolling mode (jump (fast)/scroll)
Screen mode (normal/reverse video)
Origin mode (normal/origin)
Autowrap mode (no wrap/wraparound)
Auto-repeat mode (auto-repeat/no-auto-
repeat)
Do not send/send MIT mouse row and
column on button press
Not implemented
Disallow/allow 80-to-132 mode
Off/on curses (1) fix
National replacement character set mode
(disabled)
Off/on margin bell
No reverse-wraparound/reverse
wraparound mode
Stop/start logging
Use normal/alternate screen buffer

DECCKM

DECCOLM
DECSCLM
DECSCNM
DECOM
DECAWM
DECARM

DECNRCM

Table 12-5  Escape Sequences (Continued)

Escape Sequence Action
Control
Function
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CSI ? ps ;  ps ... s Restore Digital private mode.
Permissible values for ps:

1

3
4
5
6
7
8
9

25
40
41
42

44
45

46
47

Cursor keys mode (normal/application
keypad)
Column mode (80/132 columns)
Scrolling mode (jump (fast)/scroll)
Screen mode (normal/reverse video)
Origin mode (normal/origin)
Autowrap mode (no wrap/ wraparound)
Auto-repeat/no-auto-repeat keys
Do not send/send MIT mouse row and
column on button press
Not implemented
Disallow/allow 80-to-132 mode
Off/on curses (1) fix
National replacement character set mode
(disabled)
Off/on margin bell
No reverse-wraparound/reverse
wraparound mode
Stop/start logging
Use normal/alternate screen buffer

DECCKM

DECCOLM
DECSCLM
DECSCNM
DECOM
DECAWM
DECARM

DECNRCM

CSI  ps "q
Esc [ ps " q

Select character protection attribute.
Permissible values for ps:

DECSCA

0
1
2

Not protected
Protected
Not protected

CSI 0 c
CSI  pn c
Esc [  pn c
Esc Z

Device attributes/terminal identification.
The response is CSI ?62;1;2;6;8c)

DA1
DECID

CSI pn A
Esc [  pn A

Cursor up pn times.
Default: 1.

CUU

Table 12-5  Escape Sequences (Continued)

Escape Sequence Action
Control
Function
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CSI  pn B
Esc [ pn B

Cursor down pn times.
Default: 1.

CUD

CSI pn C
Esc [ pn C

Cursor forward pn times.
Default: 1.

CUF

CSI  pn D
Esc [  pn D

Cursor backward pn times.
Default: 1.

CUB

CSI  pr ;  pc H
Esc [  pr ;  pc H

Cursor position.
Default: [1,1].

CUP

CSI  ps J
Esc [ ps J

Erase in display.
Permissible values for ps:

ED

0
1
2

Cursor to end of screen (default)
Start to cursor
Entire screen

CSI ps K
Esc [  ps K

Erase in line.
Permissible values for ps:

EL

0
1
2

Cursor to end of line (default)
Beginning to cursor
Entire line

CSI pn L
Esc [ pn L

Insert pn lines.
Default: 1.

IL

CSI  pn M
Esc [  pn M

Delete pn lines.
Default: 1.

DL

CSI pn P
Esc [ pn P

Delete pn characters.
Default: 1.

DCH

CSI  pn X
Esc [  pn X

Erase pn characters. ECH

CSI  pr ;  pc f
Esc [  pr ;  pc f

Horizontal and vertical position. HVP

Table 12-5  Escape Sequences (Continued)

Escape Sequence Action
Control
Function
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CSI  ps g
Esc [  ps g

Tab clear. Permissible values for ps: TBC

0
2
3

Clear current tab stop (default)
Clear all tab stops
Clear all tab stops

CSI  ps ;  ps ;  ps ... h
Esc [  ps ;  ps ;  ps ... h

Set Mode. Permissible values for ps: IRM
LNM

4
20

Insert mode
Line feed/new line

CSI  ps i
Esc [  ps i

Print control mode. Permissible values for ps:

0
4
5

Print page that has cursor
Exit printer controller mode
Enter printer controller mode

CSI ps ;  ps ;  ps ... l
Esc [ ps ; ps ; ps ... l

Reset Mode. Permissible values for ps: IRM
LNM

4
20

Replace mode
No line feed/no new line

Table 12-5  Escape Sequences (Continued)

Escape Sequence Action
Control
Function
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CSI ps ; ps ; ps ... m
Esc [ ps ; ps ; ps ... m

(For more information, see
“Configuring Color Text”
on page 12-30.)

(continued on next page)

Select graphic rendition (visual attributes).

Permissible values for ps:

SGR

0
1
4
5
7
22
24
25
27

Normal; clear all attributes
Bold
Underscore
Blink
Reverse video
Normal intensity, not bold
Not underlined
Not blinking
Normal video

Foreground text color:

30
31
32
33
34
35
36
37

Black
Red
Green
Yellow
Blue
Magenta
Cyan
White

Background text color:

40
41
42
43
44
45
46
47

Black
Red
Green
Yellow
Blue
Magenta
Cyan
White

Table 12-5  Escape Sequences (Continued)

Escape Sequence Action
Control
Function
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(continued from previous page)
CSI ps ; ps ; ps ... m
Esc [ ps ; ps ; ps ... m

Select graphic rendition (visual attributes).

Color-pair selection (NCD-specific values):

90
91
92
93
94
95
96
97

Color-pair0
Color-pair1
Color-pair2
Color-pair3
Color-pair4
Color-pair5
Color-pair6
Color-pair7

Table 12-5  Escape Sequences (Continued)

Escape Sequence Action
Control
Function
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CSI ps n
Esc [ ps n
or
CSI ? ps n
Esc [ ? ps n

Device status reports. DSR

ps
5
6
15

25

26

Meaning Response
Status report CSI  0  n
Cursor position report CSI  r  c  R
Printer ready CSI  ?  10  n
No printer CSI  ?  13  n  00
User-defined key status CSI  ?  20  n
      (unlocked)
 Keyboard dialect CSI  ?  27 type  n

Permissible values for type:

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16

North American
British
Flemish
Canadian French
Danish
Finnish
German
Dutch
Italian
Swiss (French)
Swiss (German)
Swedish
Norwegian
French/Belgian
Spanish
Portuguese

CSI pt ; pb r
Esc [ pt ; pb r

Set top and bottom margins (pt =top; bp=bottom).
Default: full-size window.

DECSTBM

Table 12-5  Escape Sequences (Continued)

Escape Sequence Action
Control
Function
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8-bit mode:
DCS pc ; pl | Ky1 / St1 ; . . .
Kyn / Stn ST
or
DCS pc ; pl | Ky1 \ St1 ; . . .
Kyn \ Stn ST

7-bit mode:
Esc P  pc ; pl | Ky1 / St1 ; . . .
Kyn / Stn ST
or
Esc P pc ; pl | Ky1 \ St1 ; . . .
Kyn \ Stn ST

(See “Programming
Function Keys on N-108LK
Keyboards” on page 12-28
for more information.)

User-defined keys (F6-F14, Do, Help, F17-F20): DECUDK

pc   Clear parameter. Permissible values:
0      Clear all keys before starting (resetting)
1      Clear one key at a time, as overwritten

pl    Lock parameter (no-op). Permissible values:
0      Lock the keys
1      Unlock the keys

Ky1/St1 or Ky1\St1  Key definition strings

ST  String terminator character or ESC \

Esc G (embedded space
required)

Sending 8-bit C1 control characters S8C1T

Esc F (embedded space
required)

Sending 7-bit C1 control characters S7C1T

Esc } Select locking shift of G2 character set, right LS2R

Esc = Keypad application mode DECKPAM

Esc > Keypad numeric mode DECPNM

Esc # 3 Double-width, single-height line, top DECDHL

Esc # 4 Double-width, single-height line, bottom DECDHL

Esc # 5 Single-width, single-height line DECSWL

Esc # 6 Double-width, single-height line DECDWL

Esc # 8 Screen alignment pattern DECALN

Table 12-5  Escape Sequences (Continued)

Escape Sequence Action
Control
Function
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Esc (  ps
Esc ) ps
Esc *  ps
Esc +  ps

Designate character sets:
     Select character set G0.
     Select character set G1.
     Select character set G2.
     Select character set G3.
Permitted values for ps:

SCS

ps
B
%5
<
0
A
4
C
5
R
Q
9
K
Y
E
6
\
%6
Z
H
7
=

Character set
ASCII
Digital supplementary
Digital user supplementary
Digital graphics
United Kingdom
Dutch
FINNISH
FINNISH 2
French
French Canadian
French Canadian 2
German
Italian
Norwegian
Norwegian 2
Norwegian 3
Portuguese
Spanish
Swedish
Swedish 2
Swiss

Esc | Select locking shift of G3 character set, right LS3R

Esc ~ Select locking shift of G1 character set, right LS1R

Esc 7 Save cursor DECSC

Esc 8 Restore cursor DECRC

Table 12-5  Escape Sequences (Continued)

Escape Sequence Action
Control
Function
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Esc D Index IND

Esc E New line NEL

Esc H Horizontal tab set HTS

Esc M Reverse index RI

Esc N Select single-shift of G2 character set SS2

Esc O Select single-shift of G3 character set SS3

Esc Z
Esc [ c

Send device attributes/terminal
identification. Response: CSI?62;1;2;6;8c

DECID

Esc c Hard reset RIS

Esc n Select locking shift of G2 character set LS2

Esc o Select locking shift of G3 character set LS3

OSCps ; string NP
Esc ] ps ; string NP

(For more information, see
“Configuring Window and
Icon Titles” on page 12-30.)

OSC Mode—Set icon and window titles.
Parameter variables are:

NP —Any non-printing character (discarded)

string—ASCII printable string (maximum 511
characters)

ps 0    Use string as new icon name and title
1    Use string as new icon name only
2    Use string as new title only

OSCps ND string NP
Esc ] ps ND string NP

(For more information, see
“Configuring Color Text”
on page 12-30.)

Color-pair specification (NCD-specific)
Parameter variables are defined as follows:
ps            90 to 97
ND          Any non-digit character
string foreground/background
NP          Any non-printing character

Table 12-5  Escape Sequences (Continued)

Escape Sequence Action
Control
Function
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Configuring the Status Line
The status line is referred to in Digital documents as “the 25th line of the
display.“ Because NCD Terminal Emulator windows may have more than 24
lines, the status line must be treated as the hardware status line instead of line
25.

The NCD implementation of the status line allows the programmer to create a
new line that appears at the bottom of the window. Normal programmatic
editing operations are available for this line, but different character modes
(such as blinking or bold) are not supported. To enter characters into the
status line, the programmer switches from the main display to the status line
display, then uses normal cursor control and text to add characters.

By default, the status line is not visible on the screen.

To use the status line, enable or disable it with the following sequence:

CSI ps $ -

where ps indicates which status line to use (or none):

Hence, the value 2 makes the status line appear, and 0 makes it disappear.
Note that content is not retained when the status line is hidden; the line is
emptied.

To select the status line, use the following sequence:

CSI ps $ }

where ps represents the display area to which the terminal sends data:

Once the status line is selected, all character input is directed there until the
main display is selected.

0 No status line available

1 Indicator status line (no-op)

2 Host-writable status line

0 Send characters to the main display

1 Send characters to the status line
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Programming Function Keys on N-108LK Keyboards
Fifteen of the twenty function keys on the N-108LK keyboards can be
redefined by the user. The definable function keys are:

❏ F6 through F14
❏ Do and Help
❏ F17 through F20
When redefined, the shifted state of these keys takes on the defined values.
The unshifted keys still work as usual; you cannot programmatically rebind
the unshifted state.

The two permissible formats of the escape sequences follow:

DCS pc ; pl | Ky1 / St1  ; ... Kyn / Stn  ST

DCS pc ; pl | Ky1 \ St1 ; ... Kyn / Stn  ST

The parts of a function key definition are:

DCS Device control string

pc Clear parameter:
0     Clear all keys before starting (reset)
1     Clear one key at a time, as overwritten

pl Lock parameter (no-op on NCD terminals):
0     Lock the keys
1     Unlock the keys

Ky1/St1 or Ky1\St1 Key definition string. There can be n of these,
separated by semicolons. The format is a key selector
number, a slash, then the rebinding. (See Table 12-6).
The Ky1/St1 version requires that you supply the
hexadecimal values of the letters in the key definition
string. NCD has added another option, Ky1\St1, which
allows you to supply ASCII characters for the string.

ST String terminator character, or ESC \
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Examples of function key definitions follow (spaces have been inserted for
legibility, but must not be included in the definition):

Table 12-6 Key Selector Numbers

Key Value

F6 17

F7 18

F8 19

F9 20

F10 21

F11 23

F12 24

F13 25

F14 26

Help 28

Do 29

F17 31

F18 32

F19 33

F20 34

DCS 0 ; 1 | ST Clears all key rebindings

DCS 1 ; 0 | ESC \ Locks keys (no-op on NCD terminals)

DCS 1 ; 1 | 34\ Print ST Rebinds F20 to string “Print“

DCS 1 ; 1 | 34/5052494E54 ST Rebinds F20 to string “Print“
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In the Digital implementation, there is a limitation of 256 characters combined
for all programmable function keys. NCD has a limitation of 256 characters per
rebound key.

With Digital computers, key locking and unlocking can be set through
hardware. Because NCD does not have this hardware, this function does not
work. Locking is not enforced.

Configuring Window and Icon Titles
Icon and window titles can be configured through the following escape
sequence:

OSC ps ND string NP

where:

Configuring Color Text
You can specify color text programmatically. This feature is based on the SGR
(select graphic rendition) paradigm used to control blinking, bold, inverse,
and other text attributes.

There are two methods of setting text color:

❏ Using a subset of the ISO 6429 standard for selection of basic colors for
foreground and background

❏ The Hewlett-Packard color-pair model in which you can select pairs of
any X colors for text (X colors are listed in the file /usr/lib/X11/ncd/rgb.txt.)

ps Determines how the string is used:

0—Uses string as the new icon name and window title
1—Uses string as the new icon name only
2—Uses string as the new window name only

ND Is any non-alphanumeric character (and is discarded)

string Becomes the icon name and window title (or icon name only). This
is an ASCII printable string that contains a maximum of 511
characters.

NP Is any non-printing character (and is also discarded)
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The color selection code is limited to eight combinations of colors at any given
time.

The number of combinations can be effectively doubled by using the inverse
graphics rendition, but the number of colors that can be displayed on the
screen simultaneously is limited.

ISO 6429 Color Usage
The ISO specification defines SGR sequences to change the foreground and the
background pens, as listed in Table 12-7.

For example:

CSI 31 m or ESC[ 31 m

renders foreground text in red, and

CSI 44 m or ESC[ 31 m

renders background text in blue.

These selections can be mixed to use combinations of the foreground and
background colors when rendering text. However, only eight combinations
are permitted simultaneously on the screen. The eight color cells are reused as
needed.

Table 12-7 SGR Sequences for Foreground and Background Pens

Foreground Selection Background Selection

30 black 40 black

31 red 41 red

32 green 42 green

33 yellow 43 yellow

34 blue 44 blue

35 magenta 45 magenta

36 cyan 46 cyan

37 white 47 white
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Note also that the combination of black text on a white background is always
reserved for the first color cell; hence, there are really only seven combinations
of these colors that you can select.

If you attempt to use more than seven combinations at one time, the resulting
text is displayed using color cell zero (black on white).

Hewlett-Packard Color-Pair Usage
The eight available color cells can be assigned to any combination of
foreground and background colors using NCDware-specific functionality.

This functionality builds on the SGR method of text specification with the
addition of the range of new selections listed in Table 12-8.

For example:

CSI 91 m or ESC[ 91 m

uses color-pair1 for rendering text.

Specify the colors associated with the selections by using an extension of the
OSC functions in the following format:

OSC ps ND string NP

Table 12-8 New Color-Pair Selection

Color Pair Selector Color Pair

90 color-pair0

91 color-pair1

92 color-pair2

93 color-pair3

94 color-pair4

95 color-pair5

96 color-pair6

97 color-pair7
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where:

For example:

OSC 91 ; orange/brown ^G or

ESC] 91 ; orange/brown ^G

sets color-pair1 to foreground orange, background brown.

The first color, color cell 0 (zero), is special—it is the default used for normal
text. In addition, the background of the window is reset to the background
specified with this color. In the ISO 6429 model, color cell 0 is always used for
text specified as black text on a white background. Note that this may have
been changed using the Hewlett-Packard method, which results in black text
on a white background being stored in color-pair0.

You can use the two models together, but this is somewhat tricky in terms of
cell reuse. The zero cell is never reused, but others are available to be reused if
a free cell is needed and there are no matching colors for an existing cell on the
screen. (The code scans the screen to determine if a color cell is in use when it
needs to allocate a new color selection.) As a rule, you should limit color to
eight combinations at any given time, or twice that using inverse text. If you
attempt to use more colors, the result is plain color text.

Set up new color cells as early as possible and not within loops.

Reverse video inverts all the colors that are set programmatically. The user
can select reverse video from the Options menu or use the reverseVideo
resource.

ps ranges from 90 to 97 for the color-pair selection

ND is any non-alphanumeric character (and is discarded)

string is in the format foreground/background

NP is any non-printing character (and is discarded)
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Using Keyboard Escape Sequences
An escape sequence is a series of non-printing characters, beginning with an
Escape character, that sends a command to a device. Escape sequences are
used by some legacy applications for printing, communications, and display
management. The command in an escape sequence results in specified actions
by devices. Escape sequences are also called control codes or control
sequences.

The tables in this section describe the escape sequences sent to the terminal
emulator from the following NCD keyboards: N-101/N-102, VT220/N-108LK,
and N-97/N-Kana.

Escape key sequences are sent by the following types of keys:

❏ Pressing a function key sends an escape sequence to the terminal
emulator. The following tables list the function key escape sequences for
NCD keyboards:

❏ The keypad can be set in one of two modes: numeric or application. In
numeric mode, pressing a keypad key results in a digit, numeric operator,
or enter character. In application mode, the keypad keys are similar to the
function keys in that pressing a key generates an escape sequence. The
appCursorMode resource controls the mode; the Options menu includes a
toggle (Application Cursor Mode) for local control.
The following tables list the keypad escape sequences for NCD keyboards:

❏ Pressing a key in the cursor keypad or edit keypad results in an escape
sequence. The cursor keypad can also be used in either application mode
or non-application mode. The Options menu includes a toggle
(Application Cursor Mode) to alter the mode.

Table 12-10 N-101/N-102 keyboard

Table 12-14 VT220/N-108LK keyboard

Table 12-19 N-97/N-Kana keyboard

Table 12-9 N-101/N-102 keyboard

Table 12-13 VT220 keyboard

Table 12-18 N-97/N-Kana keyboard
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The following tables list the edit keypad escape sequences:

The following tables list the cursor keypad escape sequences:

❏ Escape sequences for the Break, Shift, and Control keys for the N-108LK
keyboard in the serial terminal emulator are listed in Table 12-16.

N-101/N-102 Keyboard Escape Sequences
The tables in this section list escape sequences for N-101/N-102 keyboards.

Table 12-11 N-101/N-102 keyboard

Table 12-17 N-108LK keyboard

Table 12-12 N-101/N-102 keyboard

Table 12-15 N-108LK keyboard

Table 12-9  N-101/N-102 Keypad Escape Sequences

Key Application Mode Reset
Application Mode Set

8-bit 7-bit

0 0 SS3 p Esc O p

1 1 SS3 q Esc O q

2 2 SS3 r Esc O t

3 3 SS3 s Esc O s

4 4 SS3 t Esc O t

5 5 SS3 u Esc O u

6 6 SS3 v Esc O v

7 7 SS3 w Esc O w

8 8 SS3 x Esc O x

9 9 SS3 y Esc O y

Enter Return SS3 M Esc O M

- - SS3 m Esc O m

. . SS3 n Esc O n

+ + + +
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/ / / /

* * * *

Table 12-10  N-101/N-102 Function Key Escape Sequences

Key
Escape Sequence

8-bit 7-bit

F1 CSI 1 1 ~ Esc [ 1 1 ~

F2 CSI 1 2 ~ Esc [ 1 2 ~

F3 CSI 1 3 ~ Esc [ 1 3 ~

F4 CSI 1 4 ~ Esc [ 1 4 ~

F5 CSI 1 5 ~ Esc [ 1 5 ~

F6 CSI 1 7 ~ Esc [ 1 7 ~

F7 CSI 1 8 ~ Esc [ 1 8 ~

F8 CSI 1 9 ~ Esc [ 1 9 ~

F9 CSI 2 0 ~ Esc [ 2 0 ~

F10 CSI 2 1 ~ Esc [ 2 1 ~

F11 CSI 2 3 ~ Esc [ 2 3 ~

F12 CSI 2 4 ~ Esc [ 2 4 ~

Table 12-9  N-101/N-102 Keypad Escape Sequences (Continued)

Key Application Mode Reset
Application Mode Set

8-bit 7-bit
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Table 12-11  N-101/N-102 Editing Keypad Escape Sequences

Key
Escape Sequence

8-bit 7-bit

Insert CSI 2 ~ Esc [ 2 ~

Home CSI ^ A Esc [ ^ A

Page Up CSI 5 ~ Esc [ 5 ~

Delete CSI ^ ? Esc [ ^ ?

End CSI ^ B Esc [ ^ B

Page Down CSI 6 ~ Esc [ 6 ~

Table 12-12  N-101/N-102 Cursor Keypad Sequences

Arrow Key
Escape Sequence

8-bit 7-bit

Up CSI A Esc [ A

Down CSI B Esc [ B

Right CSI C Esc [ C

Left CSI D Esc [ D
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N-108LK (VT220-Style) Keyboard Escape Sequences
The tables in this section list escape sequences for N-108LK and VT220
keyboards.

Table 12-13  N-108LK Keypad Escape Sequences

Key
Application Mode Reset Application Mode Set

8-bit 7-bit 8-bit 7-bit

0 0 0 SS3 p Esc O p

1 1 1 SS3 q Esc O q

2 2 2 SS3 r Esc O r

3 3 3 SS3 s Esc O s

4 4 4 SS3 t Esc O t

5 5 5 SS3 u Esc O u

6 6 6 SS3 v Esc O v

7 7 7 SS3 w Esc O w

8 8 8 SS3 x Esc O x

9 9 9 SS3 y Esc O y

, , , SS3 l Esc O l

- _ _ SS3 m Esc O m

. . . SS3 n Esc O n

Enter Return Return SS3 M Esc O M

PF1 SS3 P Esc O P SS3 P Esc O P

PF2 SS3 Q Esc O Q SS3 Q Esc O Q

PF3 SS3 R Esc O R SS3 R Esc O R

PF4 SS3 S Esc O S SS3 S Esc O S
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Table 12-14  N-108LK Function Key Escape Sequences

Key
VMS ULTRIX

8-bit 7-bit 8-bit 7-bit

F1 hold screen hold screen hold screen hold screen

F2 print screen print screen print screen print screen

F3

F4

F5* Break Break Break Break

F6 CSI 1 7 ~ Esc [ 1 7 ~ CSI 1 7 ~ Esc [ 1 7 ~

F7 CSI 1 8 ~ Esc [ 1 8 ~ CSI 1 8 ~ Esc [ 1 8 ~

F8 CSI 1 9 ~ Esc [ 1 9 ~ CSI 1 9 ~ Esc [ 1 9 ~

F9 CSI 2 0 ~ Esc [ 2 0 ~ CSI 2 0 ~ Esc [ 2 0 ~

F10 CSI 2 1 ~ Esc [ 2 1 ~ CSI 2 1 ~ Esc [ 2 1 ~

F11 CSI 2 3 ~ Esc [ 2 3 ~ Esc _ Esc _

F12 CSI 2 4 ~ Esc [ 2 4 ~ Backspace Backspace

F13 CSI 2 5 ~ Esc [ 2 5 ~ Newline Newline

F14 CSI 2 6 ~ Esc [ 2 6 ~ CSI 2 6 ~ Esc [ 2 6 ~

Help CSI 2 8 ~ Esc [ 2 8 ~ CSI 2 8 ~ Esc [ 2 8 ~

Do CSI 2 9 ~ Esc [ 2 9 ~ CSI 2 9 ~ Esc [ 2 9 ~

F17 CSI 3 1 ~ Esc [ 3 1 ~ CSI 3 1 ~ Esc [ 3 1 ~

F18 CSI 3 2 ~ Esc [ 3 2 ~ CSI 3 2 ~ Esc [ 3 2 ~

F19 CSI 3 3 ~ Esc [ 3 3 ~ CSI 3 3 ~ Esc [ 3 3 ~

F20 CSI 3 4 ~ Esc [ 3 4 ~ CSI 3 4 ~ Esc [ 3 4 ~

*F5 is the break key in a serial terminal emulator only.
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Table 12-15  N-108LK  Cursor Keypad Sequences

Arrow Key
Cursor Key Mode Reset Cursor Key Mode Set

8-bit 7-bit 8-bit 7-bit

Up CSI A Esc [ A SS3 A Esc O A

Down CSI B Esc [ B SS3 B Esc O B

Right CSI C Esc [ C SS3 C Esc O C

Left CSI D Esc [ D SS3 D Esc O D

Table 12-16  N-108LK Escape Sequences–Break, Shift, and Control

Key Code Sent

Break* 250 millisecond Break

Shift-Break* 3.5 second Break & drop DTR

Control-@ NULL

Control-Space NULL

Control-Shift-Space NULL

* Break and Shift-Break apply to the serial terminal emulator only.
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Table 12-17  N-108LK Editing Keypad Escape Sequences

Key
VMS ULTRIX

8-bit 7-bit 8-bit 7-bit

Find CSI 1 ~ Esc [ 1 ~ CSI 1 ~ Esc [ 1 ~

Insert CSI 2 ~ Esc [ 2 ~ CSI 2 ~ Esc [ 2 ~

Remove CSI 3 ~ Esc [ 3 ~ CSI 3 ~ Esc [ 3 ~

Select CSI 4 ~ Esc [ 4 ~ CSI 4 ~ Esc [ 4 ~

Prior CSI 5 ~ Esc [ 5 ~ CSI 5 ~ Esc [ 5 ~

Next CSI 6 ~ Esc [ 6 ~ CSI 6 ~ Esc [ 6 ~
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N-97/N-Kana Keyboard Escape Sequences
The tables in this section list escape sequences for N-97 and N-Kana
keyboards.

Table 12-18 N-97/N-Kana Keypad Escape Sequences

Key
Application Mode Reset Application Mode Set

8-bit 7-bit 8-bit 7-bit

0 0 0 SS3 p Esc O p

1 1 1 SS3 q Esc O q

2 2 2 SS3 r Esc O r

3 3 3 SS3 s Esc O s

4 4 4 SS3 t Esc O t

5 5 5 SS3 u Esc O u

6 6 6 SS3 v Esc O v

7 7 7 SS3 w Esc O w

8 8 8 SS3 x Esc O x

9 9 9 SS3 y Esc O y

, , , SS3 l Esc O l

- _ _ SS3 m Esc O m

. . . SS3 n Esc O n

Enter Return Return SS3 M Esc O M

PF1 SS3 P Esc O P SS3 P Esc O P

PF2 SS3 Q Esc O Q SS3 Q Esc O Q

PF3 SS3 R Esc O R SS3 R Esc O R

PF4 SS3 S Esc O S SS3 S Esc O S
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Table 12-19  N-97/N-Kana Function Key Escape Sequences

Key
Escape Sequence

8-bit 7-bit

F1 CSI 1 1 ~ Esc [ 1 1 ~

F2 CSI 1 2 ~ Esc [ 1 2 ~

F3 CSI 1 3 ~ Esc [ 1 3 ~

F4 CSI 1 4 ~ Esc [ 1 4 ~

F5 CSI 1 5 ~ Esc [ 1 5 ~

F6 CSI 1 7 ~ Esc [ 1 7 ~

F7 CSI 1 8 ~ Esc [ 1 8 ~

F8 CSI 1 9 ~ Esc [ 1 9 ~

F9 CSI 2 0 ~ Esc [ 2 0 ~

F10 CSI 2 1 ~ Esc [ 2 1 ~

F11 CSI 2 3 ~ Esc [ 2 3 ~

F12 CSI 2 4 ~ Esc [ 2 4 ~
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Using Compose Key Sequences
Compose sequences, available on all keyboards, allow you to type more
characters than appear on the keyboard by using a sequence of keystrokes to
compose a single special character. You can use compose sequences in the
NCD Terminal Emulator (ncdterm or ncdrunterm).

Support for Dead Keys
Special characters called dead keys create automatic compose sequences.
When a dead key is pressed, the next key you press determines the composed
character. The N-102 French and Swiss keyboards provide dead-key support
for the following accent marks:

❏ On the French keyboard, the dieresis ( ¨ ) and circumflex  ( ˆ )
❏ On the Swiss keyboard, the acute accent ( ´ ), grave accent ( ` ),  circumflex

( ˆ ), tilde ( ˜ ), and dieresis ( ¨ )

When using these keyboards, you must first set the keyboard type to French
or Swiss by using the Boot Monitor keyboard menu before booting. For
information about the Boot Monitor keyboard menu, see Chapter 11, Boot
Monitor and NVRAM.

Typing Compose Sequences

To quickly test compose sequences, display the Terminal Host Chooser
(Console ⇒ Terminals ⇒ New Terminal). Type the compose sequences in the
Service:  window.

To type compose sequences in an NCD Terminal Emulator window (ncdterm or
ncdrunterm):

1. Make sure the eightBitInput resource is set to “true.” For example:
NCDrunterm*eightBitInput: true

2. Start the NCD Terminal Emulator and type:
% stty -istrip cs8

3. If you are using the vi text editor to enter the compose sequences, set the
environment variable LC_CTYPE to “iso_8859_1.”
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4. Find the character you want in the Character column in Table 12-20.
— On the N-108LK keyboard, press the Compose Character key; then

type the two characters in the third column.
— On any other type of keyboard, press Left/Alt and a space (hold down

Left/Alt while pressing the space bar); then type the two characters in
the Keystrokes column.

Note that the notation (sp) in the Keystrokes column in Table 12-20
indicates that you must press the space bar.

Compose Sequence Table
Table 12-20 on page 12-46 lists the characters you can compose and the
keystrokes to use.

Note The compose sequences for the currency sign and the registered
trademark symbol do not work.
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Table 12-20  Compose Sequences

"

#

'

@

[

\

]

^

`

{

|

}

~

¡

¢

£

§

¥

¤

©

ª

«

°

quotation mark

number sign

apostrophe

commercial at

opening bracket

backslash

closing bracket

circumflex accent

grave accent

opening brace

verticle line

closing brace

tilde

inverted !

cent sign

pound sign

section sign

yen

currency sign

copyright sign

female ordinal

open angle brackets

degree sign

"(sp)

++

'(sp)

AA

((

// or /<

))

^(sp)

'(sp)

(-

/^

)-

~(sp)

!!

C/ or C|

L- or L=

SO or S! or S0

Y- or Y=

XO or X0

CO or C0

A_

«

0^

Character Name Keystrokes

vertical line

1
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Table 12-20  Compose Sequences (Continued)

plus or minus sign

superscript 2

superscript 3

micro sign

paragraph sign

middle dot

superscript one

masculinf ordinal

closed angle brackets

fraction one-quarter

fraction one-half

inverted ?

A grave

A acute

A circumflex

A tilde

A umlaut

A ring

AE dphthong

C dedilla

E grave

+ –

2^

3^

/U*

P!

.^

1^

O_

»

1 4*

1 2*

??

A `

A ´

A ^

A ~

A"

A*

AE*

C,

E `

Character Name Keystrokes

±
2

3

µ

¶

•
1

º

»

1/4

1/2

¿

À

Á

Â

Ã

Ä

å

Æ

Ç

È

masculine ordinal

1

C cedilla

AE diphthong
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Table 12-20  Compose Sequences (Continued)

E umlaut

I grave

I acute

I circumflex

I umlaut

N tilde

O grave

O acute

O circumflex

O tilde

O umlaut

OE diphthong 

O slash

U grave

U acute

U circumflex

U umlaut

Y umlaut

German small sharp s

a grave

a acute

a circumflex

a tilde

E "

I `

I ´

I ^

I "

N ~

O `

O ´

O ^

O ~

O "

OE *

O/

U `

U ´

U ^

U "

Y "

ss

a `

a ´

a ^

a ~

Character Name Keystrokes

Ë

Ì

Í

Î

Ï

Ñ

Ò

Ó

Ô

Õ

Ö

Œ

Ø

Ù

Ú

Û

Ü

Ÿ

β

à

á

â

ã
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Table 12-20  Compose Sequences (Continued)

a umlaut

a ring

ae diphthong

c cedilla

e grave

e acute

e circumflex

e umlaut

i grave

i acute

i circumflex

i umlaut

n tilde

o grave

o acute

o circumflex

o tilde

o umlaut

oe diphthong

o slash

u grave

u acute

u circumflex

a "

a *

ae*

c,

e `

e ´

e ^

e "

i `

i ´

i ^

i "

n ~

o `

o ´

o ^

o ~

o "

oe *

o/

u `

u ´

u ^

Character Name Keystrokes

ä

å

æ

ç

è

é

ê

ë

ì

í

î

ï

ñ

ò

ó

ô

õ

ö

œ

ø

ù

ú

û 
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Table 12-20  Compose Sequences (Continued)

1 The compose sequences for the currency sign and registered trademark symbol do not work.

u umlaut

y umlaut

no break space

broken verticle bar

logical not

soft (syllable) hyphen

registered trademark

macron

fraction three-quarters

division sign

multiplication sign

acute accent

cedilla

diaeresis

Y acute

y acute

capital Icelandic thorn

small Icelandic thorn

capital Icelandic Eth

small Icelandic Eth

u "

y "

sp sp

|| or !

-,*

- -

RO

-^

3 4*

-:

xx

"

"

" "

Y ´

y ´

TH

th

- D

- d

Character Name Keystrokes

ü

ÿ

|

¬

–

®

¯

3/4

÷

×

´

¨

Ý

ý

broken vertical bar

1
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VT320 Character Coding Conventions
This section introduces VT320 character coding conventions and NCD
Terminal Emulator character sets. It also includes code tables for NCD
Terminal Emulator character sets.

VT320 character coding, conventions, and standards are described in detail in
Digital publications.

Character Sets
The NCD Terminal Emulator includes the following character sets:

❏ ASCII (7-bit and 8-bit)
❏ DEC Supplemental Graphic
❏ ISO Latin Alphabet 1 supplemental graphic
❏ 12 National Replacement Character sets
The default character set configuration in the NCD Terminal Emulator is
called the Digital Multinational character set. It is composed of the ASCII
character set and the Digital Supplemental Graphic character set. The NCD
Terminal Emulator maps the ASCII character set into the left side of the
character table (see Table 12-21) as the GL codes. It maps the Digital
Supplemental Graphic set into the right half (see Table 12-23) as the GR codes.

The ISO Latin Alphabet 1 supplemental graphic set is composed of the ASCII
set and the ISO Latin-1 supplemental set. (See Table 12-22.) It includes many of
the accented characters and diacritical marks used in European languages. To
use the ISO Latin Alphabet 1 supplemental graphic character set, you select
the ISO Latin 1 Font toggle in the Options menu.

By default, the NCD Terminal Emulator’s ASCII character set is 8-bit ASCII. To
change to 7-bit mode, use the Strip Parity toggle in the Options menu.

The 12 National Replacement Character sets are 7-bit character sets used with
European language keyboards. (See Table 12-24.) Each varies slightly from the
ASCII character set as required by the European language for which it is used.
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Character Code Tables
The code tables in this section describe the character codes for the character
sets included in NCD Terminal Emulator. The following conventions are used
in the code tables:

❏ Columns and rows are numbered in the top row and right-most or left-
most columns. The character codes are sometimes referred to by
columnnumber/rownumber. For example, in the Digital Multinational
Character set, Table 12-21, the character 1/0 is the control character DLE.

❏ The binary representation of a character is obtained by finding the
character code in the table, then looking at the binary representations next
to the character’s column and row numbers.

❏ The octal, decimal, and hexadecimal representations of each character are
listed to its right; the octal representation is the top number, decimal
representation is the middle number, and the hexadecimal representation
is the bottom number. For example:

ESC 107 Octal

71 Decimal

45 Hexadecimal
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Table 12-21  Digital Multinational Character Set: C0 and GL Codes

Column 0 1 2 3 4 5 6 7

Row

 b8     BITS
   b7
      b6
         b5
b4  b3  b2  b1

0
   0
      0
         0

0
   0
      0
         1

0
   0
      1
         0

0
   0
      1
         1

0
   1
      0
         0

0
   1
      0
         1

0
   1
      1
         0

0
   1
      1
         1

0 0     0     0    0 NUL o
o
o

DLE 20
16
10

SP 40
32
20

0 60
48
30

@ 100
64
40

P 120
80
50

` 140
96
60

p 160
112
70

1 0     0     0    1 SOH 1
1
1

DC1 21
17
11

! 41
33
21

1 61
49
31

A 101
65
41

Q 121
81
51

a 141
97
61

q 161
113
71

2 0     0    1     0 STX 2
2
2

DC2 22
18
12

“ 42
34
22

2 62
50
32

B 102
66
42

R 122
82
52

b 142
98
62

r 162
114
72

3 0     0     1    1 ETX 3
3
3

DC3 23
19
13

# 43
35
23

3 63
51
33

C 103
67
43

S 123
83
53

c 143
99
63

s 163
115
73

4 0     1     0    0 EOT 4
4
4

DC4 24
20
14

$ 44
36
24

4 64
52
34

D 104
68
44

T 124
84
54

d 144
100
64

t 164
116
74

5 0     1     0    1 ENQ 5
5
5

NAK 25
21
15

% 45
37
25

5 65
53
35

E 105
69
45

U 125
85
55

e 145
101
65

u 165
117
75

6 0     1     1    0 ACK 6
6
6

SYN 26
22
16

& 46
38
26

6 66
54
36

F 106
70
46

V 126
86
56

f 146
102
66

v 166
118
76

7 0     1     1    1 BEL 7
7
7

ETB 27
23
17

‘ 47
39
27

7 67
55
37

G 107
71
47

W 127
87
57

g 147
103
67

w 167
119
77

8 1     0     0    0 BS 10
8
8

CAN 30
24
18

( 50
40
28

8 70
56
38

H 110
72
48

X 130
88
58

h 150
104
68

x 170
120
78

9 1     0     0    1 HT 11
9
9

EM 31
25
19

) 51
41
29

9 71
57
39

I 111
73
49

Y 131
89
59

i 151
105
69

y 171
121
79

10 1     0     1    0 LF 12
10
A

SUB 32
26
1A

* 52
42
2A

: 72
58
3A

J 112
74
4A

Z 132
90
5A

j 152
106
6A

z 172
122
7A

11 1     0     1    1 VT 13
11
B

ESC 33
27
1B

+ 53
43
2B

; 73
59
3B

K 113
75
4B

[ 133
91
5B

k 153
107
6B

{ 173
123
7B

12 1     1     0    0 FF 14
12
C

FS 34
28
1C

, 54
44
2C

< 74
60
3C

L 114
76
4C

\ 134
92
5C

1 154
108
6C

| 174
124
7C

13 1     1     0    1 CR 15
13
D

GS 35
29
1D

- 55
45
2D

= 75
61
3D

M 115
77
4D

] 135
93
5D

m 155
109
6D

} 175
125
7D

CO CODES GL CODES  (ASCII GRAPHIC)



VT320 Character Coding Conventions

12-54  Configuring the NCD Terminal Emulator

14 1     1     1    0 SO 16
14
E

RS 36
30
1E

. 56
46
2E

> 76
62
3E

N 116
78
4E

^ 136
94
5E

n 156
110
6E

~ 176
126
7E

15 1     1     1    1 S1 17
15
F

US 37
31
1F

/ 57
47
2F

? 77
63
3F

O 117
79
4F

_ 137
95
5F

o 157
111
6F

DEL 177
127
7F

CO CODES GL CODES  (ASCII GRAPHIC)

Table 12-21  Digital Multinational Character Set: C0 and GL Codes  (Continued)

Column 0 1 2 3 4 5 6 7

Row

 b8     BITS
   b7
      b6
         b5
b4  b3  b2  b1

0
   0
      0
         0

0
   0
      0
         1

0
   0
      1
         0

0
   0
      1
         1

0
   1
      0
         0

0
   1
      0
         1

0
   1
      1
         0

0
   1
      1
         1
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Table 12-22  Digital Multinational Character Set: C1 and GR Codes

 8  9  10  11  12  13  14  15  Column

 1
    0
       0
          0

 1
    0
       0
          1

 1
    0
       1
          0

 1
    0
       1
          1

 1
    1
       0
          0

 1
    1
       0
          1

 1
    1
       1
          0

 1
    1
       1
          1

 b8       BITS
    b7
      b6
         b5
b4  b3  b2  b1

Row

200
128
80

DCS 220
144
90

240
160
A0

° 260
176
B0

 À 300
192
C0

320
208
D0

à 340
224
E0

360
240
F0

0     0     0     0  0

201
129
81

PU1 221
145
91

¡ 241
161
A1

261
177
B1

 Á 301
193
C1

Ñ 321
209
D1

á 341
225
E1

ñ 361
241
F1

0     0     0     1  1

202
130
82

PU2 222
146
92

¢ 242
162
A2

2 262
178
B2

 Â 302
194
C2

Ò 322
210
D2

â 342
226
E2

ò 362
242
F2

0     0     1     0  2

203
131
83

STS 223
147
93

£ 243
163
A3

3 263
179
B3

 Ã 303
195
C3

Ó 323
211
D3

ã 343
227
E3

ó 363
243
F3

0     0     1     1  3

IND 204
132
84

CCH 224
148
94

244
164
A4

264
180
B4

 Ä 304
196
C4

Ô 324
212
D4

ä 344
228
E4

ô 364
244
F4

0     1     0     0  4

NEL 205
133
85

MW 225
149
95

¥ 245
165
A5

µ 265
181
B5

 Å 305
197
C5

Õ 325
213
D5

å 345
229
E5

õ 365
245
F5

0     1     0     1  5

SSA 206
134
86

SPA 226
150
96

246
166
A6

¶ 266
182
B6

 Æ 306
198
C6

Ö 326
214
D6

æ 346
230
E6

ö 366
246
F6

0     1     1     0  6

ESA 207
135
87

EPA 227
151
97

§ 247
167
A7

· 267
183
B7

 Ç 307
199
C7

Œ 327
215
D7

ç 347
231
E7

œ 367
247
F7

0     1     1     1  7

HTS 210
136
88

230
152
98

¤ 250
168
A8

270
184
B8

È 310
200
C8

ø 330
216
D8

è 350
232
E8

ø 370
248
F

1     0     0     0  8

HTJ 211
137
89

231
153
99

© 251
169
A9

1 271
185
B9

É 311
201
C9

Ù 331
217
D9

é 351
233
E9

ù 371
249
F9

1     0     0     1  9

VTS 212
138
8A

232
154
9A

ª 252
170
AA

º 272
186
BA

Ê 312
202
CA

Ú 332
218
DA

ê 352
234
EA

ú 372
250
FA

1     0     1     0  10

PLD 213
139
8B

CSI 155
171
9B

« 253
171
AB

» 273
187
BB

Ë 313
203
CB

Û 333
219
DB

ë 353
235
EB

û 373
251
FB

1     0     1     1  11

PLU 214
140
8C

ST 234
156
9C

254
172
AC

1/4 274
188
BC

ì 314
204
CC

Û 334
220
DC

ì 354
236
EC

ü 374
252
FC

1     1     0     0  12

RI 215
141
8D

OSC 235
157
9D

255
173
AD

1/2 275
189
BD

Í 315
205
CD

Ÿ 335
221
DD

í 355
237
ED

 ÿ 375
253
FD

1     1     0     1  13

C1 CODES GR CODES (Digital SUPPLEMENTAL GRAPHICS)
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SS2 216
142
8E

PM 236
158
9E

256
174
AE

276
190
BE

 Î 316
206
CE

336
222
DE

î 356
238
EE

376
254
FE

1     1     1     0  14

SS3 217
143
8F

APC 237
159
9F

257
175
AF

¿ 277
191
BF

Ï 317
207
CF

ß 337
223
DF

ï 357
239
EF

377
255
FF

1     1     1     1  15

C1 CODES GR CODES (Digital SUPPLEMENTAL GRAPHICS)

Table 12-22  Digital Multinational Character Set: C1 and GR Codes  (Continued)

 8  9  10  11  12  13  14  15  Column

 1
    0
       0
          0

 1
    0
       0
          1

 1
    0
       1
          0

 1
    0
       1
          1

 1
    1
       0
          0

 1
    1
       0
          1

 1
    1
       1
          0

 1
    1
       1
          1

 b8       BITS
    b7
      b6
         b5
b4  b3  b2  b1

Row
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Table 12-23  ISO Latin-1 Supplemental Character Set: C1 and GR Codes

 8  9  10  11  12  13  14  15  Column

 1
    0
       0
          0

 1
    0
       0
          1

 1
    0
       1
          0

 1
    0
       1
          1

 1
    1
       0
          0

 1
    1
       0
          1

 1
    1
       1
          0

 1
    1
       1
          1

  b8      BITS
    b7
      b6

b5
  b4  b3   b2  b1

Row

200
128
80

DCS 220
144
90

NBSP 240
160
A0

° 260
176
B0

À 300
192
C0

capital
 Iceld.
eth*

320
208
D0

à 340
224
E0

small
Iceld.
eth*

360
240
F0

0    0    0    0  0

201
129
81

PU1 221
145
91

 ¡ 241
161
A1

261
177
B1

Á 301
193
C1

Ñ 321
209
D1

á 341
225
E1

ñ 361
241
F1

0    0    0    1  1

202
130
82

PU2 222
146
92

 ¢ 242
162
A2

2 262
178
B2

Â 302
194
C2

Ò 322
210
D2

â 342
226
E2

ò 362
242
F2

0    0    1    0  2

203
131
83

STS 223
147
93

 £ 243
163
A3

3 263
179
B3

Ã 303
195
C3

Ó 323
211
D3

ã 343
227
E3

ó 363
243
F3

0    0    1    1  3

IND 204
132
84

CCH 224
148
94

 ¤ 244
164
A4

´ 264
180
B4

Ä 304
196
C4

Ô 324
212
D4

ä 344
228
E4

ô 364
244
F4

0    1    0    0  4

NEL 205
133
85

MW 225
149
95

¥ 245
165
A5

 265
181
B5

Å 305
197
C5

Õ 325
213
D5

å 345
229
E5

õ 365
245
F5

0    1   0     1  5

SSA 206
134
86

SPA 226
150
96

broken
bar*

246
166
A6

¶ 266
182
B6

Æ 306
198
C6

Ö 326
214
D6

æ 346
230
E6

ö 366
246
F6

0    1    1    0  6

ESA 207
135
87

EPA 227
151
97

§ 247
167
A7

· 267
183
B7

Ç 307
199
C7

 X 327
215
D7

ç 347
231
E7

367
247
F7

0    1    1    1  7

HTS 210
136
88

230
152
98

“ 250
168
A8

´ 270
184
B8

È 310
200
C8

ø 330
216
D8

è 350
232
E8

ø 370
248
F8

1    0    0    0  8

HTJ 211
137
89

231
153
99

© 251
169
A9

1 271
185
B9

É 311
201
C9

Ù 331
217
D9

é 351
233
E9

ù 371
249
F9

1    0    0    1  9

VTS 212
138
8A

232
154
9A

ª 252
170
AA

º 272
186
BA

Ê 312
202
CA

Ú 332
218
DA

ê 352
234
EA

ú 372
250
FA

1    0    1    0  10

PLD 213
139
8B

CSI 233
155
9B

« 253
171
AB

» 273
187
BB

Ë 313
203
CB

Û 333
219
DB

ë 353
235
EB

û 373
251
FB

1    0    1    1  11

PLU 214
140
8C

ST 234
156
9C

¬ 254
172
AC

1/4 274
188
BC

Ì 314
204
CC

Ü 334
220
DC

ì 354
236
EC

ü 374
252
FC

1    1    0    0  12

C1 CODES GR CODES (ISO LATIN-1 SUPPLEMENTAL GRAPHICS)

* This character is illustrated in Table 12-20.
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RI 215
141
8D

OSC 235
157
9D

_ 255
173
AD

1/2 275
189
BD

 Í 315
205
CD

Y
acute*

335
221
DD

 í 355
237
ED

y
acute*

375
253
FD

1    1    0    1  13

SS2 216
142
8E

PM 236
158
9E

 ® 256
174
AE

3/4 276
190
BE

 Î 316
206
CE

EC 336
222
DE

 î 356
238
EE

small
Iceld.
thorn*

376
254
FE

1    1    1    0  14

SS3 217
143
8F

APC 237
159
9F

 – 257
175
AF

¿ 277
191
BF

 Ï 317
207
CF

 ß 337
223
DF

 ï 357
239
EF

  ÿ 377
255
FF

1    1    1    1  15

C1 CODES GR CODES (ISO LATIN-1 SUPPLEMENTAL GRAPHICS)

* This character is illustrated in Table 12-20.

Table 12-23  ISO Latin-1 Supplemental Character Set: C1 and GR Codes  (Continued)

 8  9  10  11  12  13  14  15  Column

 1
    0
       0
          0

 1
    0
       0
          1

 1
    0
       1
          0

 1
    0
       1
          1

 1
    1
       0
          0

 1
    1
       0
          1

 1
    1
       1
          0

 1
    1
       1
          1

  b8      BITS
    b7
      b6

b5
  b4  b3   b2  b1

Row
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Table 12-24  National Replacement Character Sets

Character
Set

2/3 4/0 5/11 5/12 5/13 5/14 5/15 6/0 7/11 7/12 7/13 7/14

ASCII # @ [ \ ] ^ - ` { | } ˜

United
Kingdom

£ @ [ \ ] ^ - ` { | } ˜

Dutch £ 3§4 ÿ 1⁄2 | ^ - ` ¨ ƒ 1⁄4 ´

Finnish # @ Ä Ö Å Ü - é ä ö å ü

French £ à ° ç § ^ - ` é ù è ¨

French
Canadian

# à â ç ê î - ô é ù è û

German # § Ä Ö Ü ^ - ` ä ö ü ß

Italian £ § ç é ^ - ù à ò è ì

Norwegian/
Danish

# @ Æ Ø Å ^ - ` æ ø å ˜

Portuguese # @ Ã Ç Õ ^ - ` ã ç õ ˜

Spanish £ § ¡ Ñ ¿ ^ - ` ` ° ñ ç

Swedish # É Ä Ö Å Ü - é ä ö å ü

Swiss ù à é ç ê î è ô ä ö ü û
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